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 คู่มือการจัดท าหนังสือผลงานวิจัยของส านักงานเศรษฐกิจการคลัง (สศค.) ผู้เขียนได้เรียบเรียงเนื้อหา
เพ่ือใช้เป็นแนวทางในการจัดท าหนังสือผลงานวิจัยของ สศค. ในแต่ละปีงบประมาณ ซึ่งประกอบด้วยเนื้อหา  
5 ส่วน ได้แก่ 1) บทน า 2) รู้จักโปรแกรม Microsoft Publisher 3) การจัดท าหนังสือผลงานวิจัยของ สศค.  
4) ขั้นตอนการตีพิมพ์หนังสือผลงานวิจัยของ สศค. 5) การเผยแพร่หนังสือผลงานวิจัยของ สศค.  
 ผู้เขียนหวังเป็นอย่างยิ่งว่าเนื้อหาที่ไดน้ าเสนอไว้จะเป็นประโยชน์แก่ผู้ที่สนใจทั้งในภาครัฐ และ
ภาคเอกชน ตลอดจนผู้ที่มีส่วนเกี่ยวข้อง ทั้งนี้เพ่ือให้ทุกภาคส่วนได้เล็งเห็นถึงความส าคัญของการถ่ายทอด 
องค์ความรู้ด้านการจัดท าหนังสือผลงานวิจัยของ สศค. เพ่ือให้เกิดการพัฒนาต่อยอดองค์ความรู้ในด้านการจัดท า
หนังสือผลงานวิจัยของ สศค. และองค์ความรู้ด้านอื่นๆ ที่เก่ียวข้อง ซึ่งจะท าให้การเผยแพร่ผลงานวิจัยผ่านสื่อ
ต่างๆ นั้น เกิดความน่าสนใจและทันสมัยดียิ่งขึ้นในโอกาสต่อไป 
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บทที่ 1 
บทน ำ 

ส านักงานเศรษฐกิจการคลัง (สศค.) มีภารกิจเก่ียวกับการเสนอแนะ ออกแบบนโยบาย และมาตรการ
ด้านการคลัง ระบบการเงิน รวมทั้งเศรษฐกิจมหภาคและเศรษฐกิจระหว่างประเทศ เพ่ือน าเสนอต่อผู้บริหาร
ของหน่วยงานและผู้บริหารของกระทรวงการคลัง ดังนั้นการเสนอแนะนโยบายเศรษฐกิจให้มีความสอดคล้อง
กับแผนยุทธศาสตร์ของกระทรวงการคลัง แผนพัฒนาเศรษฐกิจและสังคมแห่งชาติ แผนยุทธศาสตร์การวิจัย 
ของชาติ สศค. จึงได้ให้ความส าคัญในการสนับสนุนการเสนองานวิจัยเชิงนโยบายด้านเศรษฐกิจการคลัง 
เพ่ือใช้ข้อมูลประกอบการตัดสินใจในการผลักดันเป็นนโยบายของกระทรวงการคลังและเป็นประโยชน์ 
ต่อการพัฒนาทางด้านเศรษฐกิจของประเทศต่อไปให้มีประสิทธิภาพมากยิ่งขึ้น  

ดังนั้น ศูนย์บริหารงานวิจัยและบรรณสารสนเทศ (ศวบ.) ในฐานะที่เป็นหน่วยงานในการดูแล บริหาร
จัดการ ก ากับดูแลโครงการวิจัย วางแผนวิจัยเศรษฐกิจการคลัง การเงิน และมหภาค ติดตามความคืบหน้า 
ความส าเร็จและความสมบูรณ์ของงานวิจัยอย่างต่อเนื่อง และเผยแพร่ผลงานวิจัยออกสู่สาธารณะผ่านช่องทาง
ที่หลากหลาย ทั้งให้บริการภายในห้องสมุดของ สศค. สืบค้นข้อมูลงานวิจัยออนไลน์ ในรูปแบบ e – Book 
ผ่านระบบสารสนเทศอิเล็กทรอนิกส์ โดยเข้าใช้บริการผ่านระบบเว็บไซต์ย่อย e - book เครือข่ายอินเตอร์เน็ต 
สศค. ที ่http://www.fpo.go.th/e_research/ เพ่ือให้บุคลากรภายใน สศค. บุคลากรทางการศึกษา 
หน่วยงานภาครัฐและเอกชน ตลอดจนประชาชนทั่วไปที่มีความสนใจสามารถเข้าถึงผลงานวิจัยของ สศค.  
ได้อย่างทั่วถึง 

นอกจากนีเ้พ่ือให้ผลงานวิจัยของ สศค. เป็นที่รู้จักในวงกว้าง สามารถน าไปใช้ประโยชน์ในทางปฏิบัติ
อย่างเป็นรูปธรรมได้มากยิ่งขึ้น ศวบ. จึงได้จัดท าหนังสือผลงานวิจัยของส านักงานเศรษฐกิจการคลัง (ฉบับพกพา) 
ในแต่ละปีงบประมาณ ซึ่งเนื้อหาประกอบไปด้วยบทสรุปผู้บริหาร (Executive Summary) ทั้งภาษาไทย 
และภาษาอังกฤษ พร้อมภาพกิจกรรมในงานสัมมนาของทุกโครงการวิจัยที่ได้ด าเนินการแล้วเสร็จ 
ในปีงบประมาณนั้น ๆ รวมถึงรายชื่อโครงการวิจัยของ สศค. ที่ผ่านมา ตั้งแต่ปีงบประมาณ พ.ศ. 2551 – ปัจจุบัน 
น ามาเผยแพร่ในรูปแบบของหนังสือผลงานวิจัยของ สศค. (Pocket Book) และรูปแบบ e-Book ผ่านเว็บไซต์
ย่อยของ สศค.  

ศวบ. ตระหนักถึงประสิทธิภาพในการเผยแพร่ผลงานวิจัยของ สศค. เป็นประการส าคัญ จึงได้จัดท า
คู่มือฉบับนี้ขึ้นมา เพ่ือเป็นองค์ความรู้และแนวทางส าหรับจัดท าผลงานวิจัยของ สศค. ในโอกาสต่อไป 

 

 

http://www.fpo.go.th/e_research/%20เพื่อให้


บทที่ 2 
รู้จักโปรแกรม Microsoft Publisher 

Publisher เป็นโปรแกรมหนึ่งในชุดโปรแกรมส านักงาน (Microsoft office) ที่สามารถสร้าง 
สื่อสิ่งพิมพ์ได้หลากหลาย เช่น แผ่นพับ จดหมายข่าว บัตรอวยพร นามบัตร โปสการ์ด ปฏิทิน เป็นต้น ซึ่งผู้ใช้
สามารถสร้างได้ง่ายและไม่จ าเป็นต้องมีประสบการณ์ด้านการออกแบบกราฟิก ด้วยคุณลักษณะเด่นดังกล่าว
ของโปรแกรม Publisher ผู้จัดท าจึงได้เลือกใช้โปรแกรม Microsoft Publisher เป็นเครื่องมือในการจัดท า
หนังสือผลงานวิจัยของ สศค. ประจ าปีงบประมาณ  

2.1 กำรเริ่มต้นใช้งำนโปรแกรม Microsoft Publisher 
ปัจจุบันโปรแกรม Publisher ได้ถูกพัฒนาอย่างต่อเนื่อง เพ่ือให้สามารถเรียกใช้งานเครื่องมือและค าสั่ง

ต่างๆ ได้ง่ายและสะดวกยิ่งข้ึน และรองรับการท างานร่วมกับระบบปฏิบัติการคอมพิวเตอร์ Microsoft 
Windows ที่มีการพัฒนาเช่นเดียวกัน ดังนั้น การเรียกใช้งานโปรแกรม Publisher ผู้ใช้สามารถเรียกใช้โปรแกรม
ด้วยวิธีการค้นหาชื่อโปรแกรม โดยการ Search > (พิมพ์ชื่อโปรแกรม) Publisher ก็จะปรากฏชื่อโปรแกรม 
Microsoft Publisher  

ขั้นตอนกำรเรียกใช้งำนโปรแกรมต่อไปนี้เป็นกำรเรียกใช้งำนในระบบปฏิบัติกำร Window 7  
1. คลิกปุ่ม Start  > All Program > Microsoft Office > Microsoft Publisher 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 
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 2. โปรแกรมจะเปิดหน้าต่างดังภาพขึ้นมา ให้ผู้จัดท าได้เลือกสร้างสื่อสิ่งพิมพ์ที่โปรแกรม Publisher 
สามารถท างานได้ อีกท้ังมี Template ให้เลือกใช้เป็นตัวอย่างส าหรับมือใหม่ 

 

 3. การเปิดไฟล์งานที่บันทึกไว้ก่อนหน้า 
         ผู้จัดท าสามารถเปิดดูไฟล์งานที่เคยบันทึกไว้ก่อนหน้าได้ 2 วิธี ดังนี้ 
 วิธีที่ 1 เปิดจำกหน้ำโปรแกรม 
              1) คลิก File > Recent > เลือกไฟล์ที่ต้องดังภาพ 
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 วิธีที่ 2 เปิดจำกโฟลเดอร์ที่จัดเก็บ 
              1) คลิก File > Open > จะปรากฏหน้าต่าง Open Publisher จากนั้นเลือกพ้ืนที่จัดเก็บไฟล์ 
และดับเบิ้ลคลิกไฟล์ที่ต้องการ หรือคลิกปุ่ม Open 

 

 4. การปิดโปรแกรม 
ผู้จัดท าสามารถปิดโปรแกรมหลังจากใช้งานเสร็จแล้วได้ที่ Program Windows Control (ปุ่ม

ควบคุมหน้าต่างกระดาษ) และเลือกปุ่ม   

1 

3 

2 

4 

5 
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2.2 ส่วนประกอบของโปรแกรม Microsoft Publisher 

 

1. Titlebar (ไตเติลบำร์) : แสดงรายชื่อกระดาษและรายชื่อโปรแกรม 

2. Quick Access Toolbar (แถบเครื่องมือด่วน) : ปุ่มค าสั่งที่เรียกใช้งานบ่อย ซึ่งสามารถเพ่ิมเติม
ขึ้นมาได้ภายหลัง 

3. Ribbon (ริบบอน) : ประกอบไปด้วยแท็บต่างๆ ซึ่งภายในแท็บประกอบไปด้วยค าสั่งต่างๆ 
ฟังก์ชันการท างานที่วางเป็นแถวและแถบเครื่องมือย่อย 

4. Document Windows (หน้ำต่ำงกระดำษ) : เป็นพื้นที่ส าหรับพิมพ์ข้อความ แทรกรูปภาพ  
หรือตาราง  

5. Page Navigation (กำรน ำทำงเพจ) : ตัวเลือกหน้ากระดาษ  

6. Status bar (แถบสำธำรณะ) : แสดงสถานการณ์ท างานของโปรแกรม 

7. Document Map (แมปกระดำษ) : ใช้แสดงหน้ากระดาษในรูปแบบต่างๆ 

8. Zoom in - Zoom out (ย่อ/ขยำยหน้ำกระดำษ) : ใช้ย่อ/ขยายหน้ากระดาษ 

9. Program Windows Control (ปุ่มควบคุมหน้ำต่ำงกระดำษ) 

       : ย่อหน้าต่างกระดาษ                                   

      : ปรับ – ลดขนาดหน้าต่างกระดาษ 
  : ปิดหน้าต่างกระดาษ 

 
 
 

1 3 
2 

5 

4 

6 7 8 

9 



บทที่ 3 
กำรจัดท ำหนังสือผลงำนวิจัยของ สศค.  

ประจ ำปีงบประมำณ 

 หนังสือผลงานวิจัยของ สศค. ที่จัดท าข้ึน ประกอบด้วย ค าน า สารบัญ บทสรุปผู้บริหาร (Executive 
Summary) ทั้งภาษาไทยและภาษาอังกฤษ ภาพกิจกรรม รายชื่อโครงการวิจัยของ สศค. ตั้งแต่ปีงบประมาณ 
พ.ศ. 2551 – ปัจจุบัน และรายชื่อของผู้ทรงคุณวุฒิของวิจัยแต่ละโครงการที่สิ้นสุดในปีงบประมาณนั้นๆ  
โดยรวบรวมเนื้อหาทั้งหมดมาจัดเรียงในรูปแบบของหนังสือผลงานวิจัยของ สศค. หรือ Pocket Book  
ให้เรียบร้อยก่อนน าไปจัดพิมพ์เป็นรูปเล่ม และเผยแพร่ให้แก่ผู้สนใจงานวิจัยต่อไป  

3.1 ขั้นตอนกำรเตรียมกำรจัดท ำหนังสือผลงำนวิจัยของ สศค. 
 ผู้จัดท าสร้างโฟลเดอร์เพ่ือใช้เป็นแหล่งรวบรวมไฟล์เนื้อหาทั้งหมดท่ีอยู่ใน Pocket Book ทั้งนี้การต้ัง

ชื่อโฟลเดอร์แต่ละโฟลเดอร์ควรตั้งชื่อที่ผู้จัดท าเข้าใจและสามารถค้นหาได้สะดวก ตัวอย่างเช่น “Pocket 
Book 60” และสร้างโฟลเดอร์ย่อยภายใต้โฟลเดอร์ Pocket Book 60 ดังนี้ 
1. โฟลเดอร์ส าหรับจัดเก็บไฟล์ข้อมูลที่เป็นนามสกุลของโปรแกรม Publisher (.pub) ตัวอย่างเช่น “PB.pub” 
2. โฟลเดอร์ส าหรับจัดเก็บไฟล์ PDF ตัวอย่างเช่น “PB.pdf” 
3. โฟลเดอร์ส าหรับจัดเก็บรูปภาพที่อยู่ภายในเล่มหนังสือผลงานวิจัยของ สศค. โดยตั้งชื่อไฟล์ภาพตามงานวิจัย 
4. โฟลเดอร์ส าหรับจัดเก็บไฟล์บทสรุปผู้บริหารแต่ละโครงการงานวิจัย โดยน าไฟล์ข้อมูลจากแผ่น CD ที่ได้รับ
จากนักวิจัย ท าการคัดลอกไฟล์เฉพาะบทสรุปผู้บริหารเนื้อหาที่เป็นภาษาไทยและภาษาอังกฤษ บันทึกลงใน
โฟลเดอร์ และตั้งชื่อไฟล์ตามชื่อโครงการวิจัย พร้อมทั้งคัดลอกรูปภาพของงานวิจัยแต่ละโครงการวางลงใน
โฟลเดอร์นี้ด้วย เพ่ือน าข้อมูลมาใช้ในการจัดท าหนังสือผลงานวิจัยของ สศค. 
 ซึ่งข้อที่ 1 – 3 เป็นโฟลเดอร์ข้อมูลที่ผู้จัดท าจะต้องน าส่งให้บริษัทเมื่อเรียบเรียงเนื้อหาหนังสือผลงานวิจัย
ของ สศค. เสร็จเรียบร้อยแล้ว และเข้าสู่ขั้นตอนการจัดพิมพ์ในบทที่ 4 

3.2 ขั้นตอนกำรตั้งค่ำหน้ำกระดำษ 
 เนื่องจากหนังสือผลงานวิจัยของ สศค. มีขนาด A5 หรือประมาณครึ่งหนึ่งของ A4  ผู้จัดท าจะต้อง
เลือกรูปแบบหน้ากระดาษและตั้งค่าหน้ากระดาษให้เรียบร้อยก่อนการใส่ข้อความ รูปทรงเรขาคณิต รูปภาพ 
และตารางลงหน้ากระดาษ ดังขั้นตอนต่อไปนี้ 
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 1) คลิกเลือก More Blank Page Sizes หลังจากนั้นจะปรากฏขนาดหน้ากระดาษมาตรฐานที่ใช้ 
ในการสร้างสื่อสิ่งพิมพ์ 

 
2) คลิกเลือก A5 (Portrait) 14.8x21cm ซึ่งเป็นหน้ากระดาษขนาด A5 แนวตั้ง และคลิก Create  

จะปรากฏหน้ากระดาษที่มีขนาด A5 

 

 
 

 

1 

1 

2 
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3) หลังจากนั้นคลิกแท็บ Page Design และคลิก  ในกลุ่มค าสั่ง Page Setup เพ่ือตั้งค่า
รายละเอียดหน้ากระดาษในการท าหนังสือผลงานวิจัยของ สศค. 
 

 
 4) ตั้งค่ารายละเอียดหน้ากระดาษต่างๆ ดังรูป เพ่ือจัดระยะขอบของหน้ากระดาษ 

ส าหรับการเข้าเล่ม 

 
 5) คลิก OK เพ่ือจบการตั้งค่าหน้ากระดาษ 

 

 

1 

2 
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Note : ค าอธิบายการตั้งค่ารายละเอียดหน้ากระดาษ 

Page : ก าหนดขนาดความกว้างและความสูงของพ้ืนที่เอกสาร 
 Width : ขนาดความกว้าง       Height : ขนาดความสูง 

Margin Guides : ก าหนดขนาดของเส้นไกด์ส าหรับบอกขอบเขตของพ้ืนที่การสร้างข้อมูลลงใน
หน้ากระดาษ เพ่ือให้สร้างข้อมูลอยู่ภายใต้เส้นไกด์เท่านั้น 
 Top : ระยะห่างด้านบนระหว่างขอบกระดาษกับเส้นไกด์ 
 Left : ระยะห่างด้านซ้ายระหว่างขอบกระดาษกับเส้นไกด์ 
 Bottom : ระยะห่างด้านล่างระหว่างขอบกระดาษกับเส้นไกด์ 
 Right : ระยะห่างด้านขวาระหว่างขอบกระดาษกับเส้นไกด์ 

Layout type : รูปแบบของลักษณะงาน 
 One page per sheet : หนึ่งหน้า  Folded card : การ์ด 
 Booklet : สมุด    Multiple page sheet : ทุกหน้า 
 E-mail : ไฟล์ส าหรับการส่งอีเมล์  Web page : สร้างหน้าเว็บ 
 Envelope : ซองจดหมาย 

Option : ก าหนดค่าขนาดเพ่ิมเติม 
Preview : ตัวอย่างขนาดพ้ืนที่ที่ได้ตั้งค่าไว้ 
OK : เมื่อต้องการใช้งานการตั้งค่าดังกล่าวและปิดหน้าต่างการท างานในหน้านี้ 
Cancel :  ยกเลิกการตั้งค่าและปิดหน้าต่างการท างานในหน้านี้ 
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 6) สร้างหน้า Master Page ส าหรับท าหนังสือที่มีหัวกระดาษและท้ายกระดาษ โดยคลิกแท็บ  
Insert > Header  

 
 7) คลิก Two Page Master จะปรากฏกระดาษเป็นหน้าคู่ หลังจากนั้นคลิก Close Master Page 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
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3.3 ขั้นตอนกำรท ำหนังสือผลงำนวิจัยของ สศค. (ส่วนของเนื้อหำ) 

สร้างกล่องข้อความ ส าหรับใส่เนื้อหาต่างๆ เช่น ค าน า สารบัญ บทสรุปผู้บริหาร (Executive Summary) 
ทั้งภาษาไทยและภาษาอังกฤษ รายชื่อโครงการวิจัยของ สศค. ตั้งแต่ปีงบประมาณ  พ.ศ. 2551 – ปัจจุบัน 
และรายชื่อของผู้ทรงคุณวุฒิของวิจัยแต่ละโครงการที่สิ้นสุดในปีงบประมาณนั้นๆ ลงในหน้ากระดาษ  
และผู้จัดท าจะต้องบันทึกไฟล์ข้อมูล 1 ไฟล์ ต่อ 1 บท โดยบันทึกไฟล์ข้อมูลทั้งไฟล์นามสกุลของโปรแกรม 
Publisher และ PDF สามารถดูขั้นตอนการบันทึกไฟล์ได้ที่หน้า 32 (ข้อ 3.5 ขั้นตอนการบันทึกไฟล์)  
ซึ่งกระบวนการท าหนังสือผลงานวิจัยของ สศค. (ส่วนของเนื้อหา) มีดังนี้  
 1) คลิก Home > Draw Text Box โดยวาดกล่องข้อความให้พอดีกับเส้น Guide สีฟ้า เพื่อให้เป็น
มาตรฐานในการจัดรูปแบบข้อความที่มีขนาดเท่ากันทุกๆ หน้า ดังนั้น ผู้จัดท าควรใส่ข้อความให้อยู่ภายใน
กรอบเส้น Guide สีฟ้าเท่านั้น ซึ่งเนื้อหาบทสรุปผู้บริหาร (Executive Summary) ทั้งภาษาไทยและภาษาอังกฤษ 
ผู้จัดท าสามารถน าเนื้อหาจากโฟลเดอร์ที่ได้จัดเก็บไฟล์บทสรุปผู้บริหารแต่ละโครงการงานวิจัยไว้ในขั้นตอน 
การเตรียมการจัดท าหนังสือผลงานวิจัยของ สศค. 

 
หมำยเหตุ ถ้ากล่องข้อความที่ผู้จัดท าสร้างขึ้นปรากฏจุดสีแดง หรือสัญลักษณ์  แสดงถึงข้อความยาวเกิน
ขนาดกล่องข้อความที่สร้างไว้ ให้แก้ไขโดยการขยายกล่องข้อความ (ด้วยการดึงกล่องข้อความลงด้านล่าง 
เพราะสามารถตรวจสอบข้อความท่ีเกินหน้ากระดาษนี้ได้ง่าย) และลบข้อความที่เกินหน้ากระดาษหรืออยู่นอก
เส้น Guide สีฟ้าออก และย่อกล่องข้อความให้มีขนาดเท่าเดิม 

 2) เมื่อผู้จัดท าใส่ข้อความ หรือเนื้อหาลงหน้ากระดาษเต็มกล่องข้อความแล้ว ให้น าเคอร์เซอร์ 
วางในกล่องข้อความ หลังจากนั้นคลิก Home เลือกเครื่องมือ Paragraph เพ่ือจัดข้อความให้มีความสวยงาม
และเป็นระเบียบ 

 

2 

1 

วาดกล่องข้อความให้พอดีกับเส้น Guide สีฟ้า
kgvdlkimuj9hv’dki][ 

3 

2 

1 
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3) ส าหรับเนื้อหาที่มีข้อความเป็นความเรียงให้เลือก Indents and Spacing และตั้งค่า Alignment: 
เป็น Inter-cluster เพราะจะเป็นการกั้นหน้า – กั้นหลังที่ท าให้ข้อความมีความสวยงามและสมบูรณ์ที่สุด 

 

ตัวอย่ำงผลลัพธ์กำรจัดกลุ่มข้อควำมของ Inter-cluster 

 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
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 4) เพิ่มหน้ากระดาษใหม่ เพื่อใส่ข้อความหรือเนื้อหาเพ่ิมเติม สามารถท าได้ 2 วิธี ดังนี้ 
             วิธีที่ 1  
 1. เลือกหน้าใดหน้าหนึ่งที่อยู่ด้านซ้ายมือตรง Page Navigation จากนั้นคลิกขวาจะปรากฏค าสั่ง 
และเลือกค าสั่ง Insert Page 

 
 2. ปรากฏหน้าต่างโต้ตอบอัตโนมัติ เลือกรูปแบบหน้ากระดาษที่ต้องการเพ่ิม 

 
 3. คลิก OK เพ่ือเสร็จสิ้นการเพ่ิมหน้ากระดาษ 

 

 

 

 

คลิกขวา 

แทรกหน้าด้านบนของหน้าที่เลือก 

แทรกหน้าด้านลา่งของหน้าที่เลือก 

ระบุจ านวนหน้าที่ต้องการแทรกเพิ่ม 

แทรกหน้าว่าง 

สร้างกล่องข้อความในหน้าว่าง 

เลือกหน้าที่จะท าซ้ า 

1 

2 
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 วิธีที่ 2 

 1. คลิกแท็บ Insert และคลิก  จะปรากฏเมนูย่อยของการเพ่ิมรูปแบบหน้ากระดาษ 

 
 2. เลือกรูปแบบของหน้ากระดาษที่ต้องการเพิ่ม 
    Insert Blank : เพ่ิมหน้าว่าง 
    Insert Duplicate Page : ท าซ้ าหน้ากระดาษ 
    Insert Page : การเพ่ิมหน้ากระดาษแบบก าหนดรายละเอียด 
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Note : กำรลบหน้ำกระดำษ 
          1. เลือกหน้ากระดาษที่ต้องการลบด้านซ้ายมือตรง Page Navigation จากนั้นคลิกขวาจะปรากฏ
ค าสั่ง และเลือกค าสั่ง delete 

 
 2. ปรากฏหน้าต่างโต้ตอบอัตโนมัติ และคลิก Yes เพ่ือเสร็จสิ้นการลบหน้ากระดาษ 

 
 

คลิกขวา (หน้ากระดาษที่ต้องการลบ)
kgvdlkimuj9hv’dki][ 

2 

1 
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 เนื่องจากในเนื้อหาบางบทผู้จัดท าอาจมีความจ าเป็นต้องแทรกตาราง รูปภาพ หรือรูปทรงเลขาคณิต
ลงในหน้ากระดาษ เพ่ืออธิบายขยายความเพ่ิมเติมให้ข้อมูลเนื้อหานั้นมีความชัดเจน สามารถเข้าใจได้มากยิ่งขึ้น 
ซึ่งมีข้ันตอนรายละเอียด ดังนี้ 
 3.3.1 กำรแทรกตำรำง  
 สามารถแทรกได้ 2 วิธี 
     วิธีที่ 1 การแทรกตารางแบบรวดเร็ว 
     1) คลิกแท็บ Insert เลือกค าสั่ง Table 

 
 2) ย้ายเคอร์เซอร์ไปไว้เหนือเส้นตารางตามจ านวนของคอลัมน์และแถวที่ต้องการ หลังจากนั้น
คลิกตารางจะปรากฏในสิ่งพิมพ์ 

 

1 

1 

คลิก 2 

2 
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 วิธีที่ 2 การแทรกตารางท่ี มีมากกว่า 10 คอลัมน์และ 8 แถว 
    1) คลิกแท็บ Table > Insert table หลังจากนั้นจะปรากฏกล่องโต้ตอบอัตโนมัติ 

 
 2) ผู้จัดท ากรอกจ านวนแถว (Number of rows) และจ านวนคอลัมน์ (Number of 
columns) และคลิก OK เพ่ือเสร็จสิ้นการแทรกตาราง 

 
  
หมำยเหตุ การสร้างตารางในโปรแกรม Publisher ผู้จัดท าจะต้องใส่เส้นตารางเอง มิเช่นนั้นตารางที่ได้จะไม่มี
เส้นตาราง โดยผู้จัดท าคลิกในตาราง และคลิกแท็บ Design ซึ่งการใส่สีเส้นตาราง และเส้นตาราง จะอยู่ใน
กลุ่มค าสั่ง Borders 

          3.3.1.1 การปรับปรุงตาราง ผู้จัดท าคลิกในตาราง แท็บเครื่องมือส าหรับปรับปรุงตาราง 
(Table Tools) จะปรากฏขึ้น แท็บนี้สามารถเพ่ิม – ลบ แถวตารางได้ และเพ่ิมเส้น สีขอบตาราง หรือใส่สีตาราง 

 
 
 

1 

2 

กรอกจ านวนแถวและคอลัมน์ที่ต้องการ 1 

2 
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 3.3.2 กำรแทรกรูปภำพ  
   1) คลิกแท็บ Insert > Picture หลังจากนั้นจะปรากฏหน้าต่างโต้ตอบอัตโนมัติ 

 
    2) เลือกไฟล์รูปภาพที่ต้องการ และคลิก Insert 

 
 

 

 

 

 

 

 

1 

2 

เลือกไฟล์รูปที่ต้องการ 1 

2 
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 3.3.3 กำรแทรกรูปทรงเลขำคณิต  
  1) คลิกแท็บ Insert > Shapes และเลือกรูปทรงเลขาคณิตที่ต้องการ  

 
 
 
 
 

 

 

 

 

 

 

1 2 

เลือกรูปทรงเลขาคณิตที่ต้องการ 3 
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            2) วาดรูปร่างในต าแหน่งที่ต้องการในกระดาษ แล้วลากเพ่ือวางรูปร่าง 

 
 3.3.3.1 การปรับปรุงรูปทรงเลขาคณิต ผู้จัดท าคลิกรูปทรงเลขาคณิต แท็บเครื่องมือส าหรับ
ปรับปรุงรูปร่าง (Drawing Tools) จะปรากฏขึ้น แท็บนีส้ามารถปรับแต่งรูปร่างได้ตามต้องการ เช่น  
ใส่สีเส้นขอบ สีรูปร่าง หรือการใส่เอฟเฟ็กต์อ่ืนๆ 
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 3.3.4 กำรจัดท ำหัวกระดำษและเลขหน้ำ  
                   แทรกหัวกระดาษและเลขหน้า ผู้จัดท าสามารถท าในขั้นตอนเดียวกันได้ โดยหัวกระดาษ 
และเลขหน้าจะอยู่นอกกรอบเส้น Guide สีฟ้า 
              3.3.4.1 ขั้นตอนกำรจัดท ำหัวกระดำษ 
                     1) คลิกแท็บ Insert > Header จะปรากฏหน้าต่างการสร้างหัวกระดาษและท้าย
กระดาษ 

 
      2) สร้างหัวกระดาษ โดยฝั่งซ้ายพิมพ์ชื่อเรื่องลงในกล่องข้อความ และฝั่งขวาใส่โลโก้
ของ สศค. ซึ่งการใส่โลโก้ สศค. เป็นการแทรกรูปภาพ ผู้จัดท าสามารถดูวิธีการแทรกรูปภาพได้จากข้อ 3.3.2  
การแทรกรูปภาพ (หน้า 17) 

 
              3.3.4.2 ขั้นตอนกำรจัดท ำเลขหน้ำ 
                              1) ผูจ้ัดท าคลิกด้านล่างของกระดาษ ทั้งด้านซ้ายและด้านขวา 

 
 

คลิก เพื่อใส่เลขหน้า 

1 2 

ใส่ช่ือเรื่องของโครงการวิจัย ฝ่ังซ้ำย ใส่โลโก้ของ สศค. ฝ่ังขวำ 

1
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                          2) คลิก Insert Page Number หลังจากนั้นจะปรากฏสัญลักษณ์ # ขึ้นมาแทนตัวเลข 
แต่จะปรากฏเป็นตัวเลข เมื่อปิดหน้าจอการแทรกหัวกระดาษและเลขหน้า 

 
                            3) เมื่อผู้จัดท าแทรกหัวกระดาษและเลขหน้าเรียบร้อยแล้ว ให้คลิก Close Master 
Page เพ่ือเสร็จสิ้นการแทรกหัวกระดาษและเลขหน้า 

 
หมำยเหตุ ผู้จัดท าสามารถปรับแต่งลักษณะของหัวกระดาษและเลขหน้า หรือต าแหน่งการจัดวาง โดยการคลิก
แท็บ Home ขณะอยู่ในขั้นตอนการแทรกหัวกระดาษและเลขหน้า เมื่อปรับแต่งเสร็จแล้วให้ผู้ใช้คลิกแท็บ 
Master Page เพ่ือกลับมายังหน้าแทรกหัวกระดาษและเลขหน้าอีกครั้ง และคลิก Close Master Page  

 

 

 

1 

1 
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               3.3.4.3 ขั้นตอนกำรแก้ไขเลขหน้ำ 
                                1) คลิกแท็บ Insert > Page Number > Format Page Number  
หลังจากนั้นปรากฏหน้าต่างให้แก้ไขเลขหน้า 

 
                                 2) ผู้จัดท าสามารถเลือกรูปแบบตัวเลข และตั้งค่าเลขเริ่มต้น 
ของหน้ากระดาษ หลังจากนั้นคลิก OK เพ่ือเสร็จสิ้นการแก้ไขเลขหน้า 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

1 

2 

3 
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3.4 ขั้นตอนกำรท ำหนังสือผลงำนวิจัยของ สศค. (ส่วนของภำพกิจกรรม) 
 ผู้จัดท าตั้งค่าหน้ากระดาษตามข้ันตอนในหน้าที่ 6 (ข้อ 3.2 ขั้นตอนการตั้งค่าหน้ากระดาษ)  
1) คลิก Insert > Shapes เลอืกรูปร่างสี่เหลี่ยมผืนผ้า 

 
2) คลิกเมาส์ค้างแล้ววาดรูปร่างสี่เหลี่ยมผืนผ้าบนหัวกระดาษ โดยวาดให้เกินขอบกระดาษออกมา

ประมาณ 0.5 เซนติเมตร หลังจากนั้นใส่สี หรือเส้นขอบตามต้องการ  

 
 
 
 
 
 

1 

เลือกรูปร่างสี่เหลี่ยมจัตุรัส 2 
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3) คลิก Insert > Text Box วาดกล่องข้อความทับรูปร่างที่วาดก่อนหน้าแต่กล่องข้อความจะต้องไม่
อยู่นอกขอบกระดาษ หลังจากนั้นพิมพ์ชื่อโครงการวิจัย  

 
4) คลิกเลือกรูปร่างสี่เหลี่ยมผืนผ้าอีกครั้ง และวาดให้มีขนาดเล็กใต้ชื่อโครงการวิจัย เพ่ือใส่ชื่อหัวหน้า

โครงการวิจัย โดยหน้าที่ 1 หรือหน้าคี่ ชื่อหัวหน้าโครงการวิจัยจะอยู่ฝั่งซ้าย ดังภาพ 

 
 
 
 
 
 
 
 
 
 
 



ศูนย์บริหารงานวิจัยและบรรณสารสนเทศ  26 
 

5) คลิกเลือกรูปร่างสี่เหลี่ยมผืนผ้าและคลิกวาดท้ายกระดาษ ซึ่งสี่เหลี่ยมผืนผ้าที่วาดมีขนาดประมาณ
ใส่ข้อความได้ 1 บรรทัด หลังจากนั้นแทรกกล่องข้อความท้ายกระดาษ เพ่ือพิมพ์วันที่ สถานที่จัดสัมมนา  
และใส่โลโก้ สศค. 

 
6) แทรกรูปภาพของโครงการวิจัย โดยเลือกรูปภาพจากโฟลเดอร์ภาพงานวิจัยให้ตรงกับชื่อ

โครงการวิจัยบนหัวกระดาษ หลังจากนั้นคลิกเลือกรูปที่ต้องการและคลิก Insert 

 

เลือกรูปภาพที่ต้องการ 

เลือกโฟลเดอร์ภาพงานวิจัย 

1 

2 

3 

4 
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7) จัดวางรูปภาพตามแบบที่ต้องการ 

 
8) เมื่อท าเสร็จ 1 โครงการวิจัยให้แทรกหน้าเพ่ิม โดยใช้วิธีการท าซ้ า (Insert Duplicate Page) 
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9) ส าหรับหน้าที่ 2 หรือหน้าคู่ ให้ย้ายรูปร่างและกล่องข้อความที่ใส่ชื่อหัวหน้าโครงการวิจัยไว้ด้านขวา 
และแก้ไขชื่อโครงการวิจัยและหัวหน้าโครงการวิจัย 

 
10) แก้ไขวันที่และสถานที่จัดสัมมนาให้ตรงกับโครงการวิจัยนั้นๆ และให้สลับต าแหน่งโลโก้ สศค.  

กับข้อความ (วันที่และสถานที่จัดสัมมนา) ให้อยู่ต าแหน่งตรงข้ามกัน ดังภาพ 
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11) แทรกรูปภาพโครงการวิจัย และจัดวางให้สวยงามไปในทิศทางหรือรูปแบบเดียวกันทุกโครงการ 

 
12) เมื่อท าเสร็จแล้วให้คลิก Insert Duplicate หลังจากนั้นให้ผู้จัดท าแก้ไขรายละเอียดและรูปภาพ 

ให้สอดคล้องกับชื่อโครงการวิจัยที่เพิ่มเข้ามา ท าจนครบทุกโครงการในปีงบประมาณ และบันทึกไฟล์ข้อมูล 
ทั้งไฟล์นามสกุลของโปรแกรม Publisher และ PDF 
หมำยเหตุ การจัดวางชื่อหัวหน้าหน้าโครงการวิจัย และท้ายกระดาษให้ผู้จัดท าจัดวางสลับหน้าคี่และหน้าคู่ 
กล่าวคือ หากชื่อหัวหน้าหน้าโครงการวิจัยหน้าคี่อยู่ฝั่งขวา หน้าคู่จะอยู่ฝั่งซ้าย เช่นเดียวกับท้ายกระดาษ ถ้า
หน้าคี่โลโก้อยู่ฝั่งขวา หน้าคู่โลโก้จะต้องอยู่ฝั่งซ้าย 
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Note : กำรบันทึกไฟล์ PDF ส ำหรับส่วนของภำพกิจกรรม 
 จากข้ันตอนการวาดรูปร่างที่บอกให้ผู้จัดท าวาดรูปร่างเกินขอบกระดาษออกมาประมาณ 0.5 ซม 
เนื่องจากไฟล์ข้อมูลในส่วนนี้เมื่อน าเข้าโรงพิมพ์ และสั่งพิมพ์ออกมาจะต้องมีการตัดแต่งขอบกระดาษอีกครั้ง 
ดังนั้น ส่วนของการบันทึกไฟล์เป็น PDF เฉพาะส่วนของภาพกิจกรรมจึงจะต้องปรับการตั้งค่าการบันทึก
เพ่ิมเติมจากไฟล์ทั่วไป ตามขั้นตอนต่อไปนี้ 

1. คลิก save as  ตั้งชื่อไฟล์ และเลือกชนิดไฟล์ PDF 

 
2. คลิก Options…  

 
 

1 

ตั้งชื่อไฟล์ 1 

2 
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3.5 ขั้นตอนกำรบันทึกไฟล์ 

3. คลิก Print Options…  

 
4. ตั้งค่ารายละเอียดของกระดาษดังภาพ  โดยเพิ่มความกว้าง (Width : 15.8) และความสูง (Height : 22) 
และคลิก OK > OK > Save เสร็จสิ้นการบันทึกส่วนของภาพกิจกรรม 

 
 

1 
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ขั้นตอนนี้จะแนะวิธีการส าหรบับันทึกครั้งแรก การบันทึกชื่อไฟล์ใหม่ ซึ่งเป็นนามสกุลของโปรแกรม 
 (.pub) และการบันทึกไฟล์ PDF เมื่อผู้จัดท าใส่เนื้อหาครบ 1 บท ทั้งนี้ไฟล์ข้อมูลทั้งโปรแกรม Publisher  
และ PDF จะต้องบันทึกลงในโฟลเดอร์ที่สร้างไว้ในหน้า 6 (ขัน้ตอนที่ 3.1 ขั้นตอนการเตรียมการจัดท าหนังสือ
ผลงานวิจัยของ สศค.)  

 3.5.1 กำรบันทึกไฟล์ครั้งแรก 
1) ให้ผู้จัดท าคลิก save (บันทึก) รูปไอคอน        ซึ่งอยู่ท่ี Quick Access Toolbar  

(แถบเครื่องมือด่วน) หลังจากนั้นจะปรากฏหน้าต่างโต้ตอบอัตโนมัติขึ้นมา  

 
2) เลือกต าแหน่งที่ต้องการจัดเก็บไฟล์ เลือกโฟลเดอร์ Pocket Book 59 > PB.pub  

และตั้งชื่อไฟล์  (File name: ) 

 
3) คลิก save เพ่ือจบการบันทึก 

หมำยเหตุ การตั้งชื่อไฟล์ควรตั้งชื่อที่สื่อถึงงานนั้นๆ ให้ชัดเจน ตรงประเด็น และใส่ล าดับเลขหน้าชื่อเรื่อง  
เพ่ือสะดวกในการจัดเรียงเนื้อหาในการตีพิมพ์ 

ตั้งช่ือไฟล ์1 

1 
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3.5.2 กำรบันทึกช่ือไฟล์ใหม่ 
1) ให้ผู้จัดท าคลิกแท็บ File (แฟ้ม) และคลิก Save as หลงัจากนั้นจะปรากฏหน้าต่าง 

โต้ตอบอัตโนมัติ 

 
2) เลือกต าแหน่งที่จัดเก็บไฟล์ และตั้งชื่อไฟล์ (File name: )  

 
3) คลิก save เพ่ือจบการบันทึก 

 
 
 

1 

2 

ตั้งช่ือไฟล ์1 
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3.5.3 กำรบันทึกไฟล์ PDF 
 1) ให้ผู้จัดท าคลิกแท็บ File (แฟ้ม) และคลิก Save as หลงัจากนั้นจะปรากฏหน้าต่างโต้ตอบ
อัตโนมัติ 

 

      2) เลือกต าแหน่งที่จัดเก็บไฟล์ และตั้งชื่อไฟล์ (File name: )  

 
 

 

 

 

1 

2 

ตั้งช่ือไฟล ์1 
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  3) คลิกเลือกชนิดไฟล์ (Save as type: PDF) 

 
 4) คลิก save เพ่ือจบการบันทึก 

 
 

เลือกชนิดไฟล์เป็น PDF 1 
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3.6 กำรสั่งพิมพ์งำน 
 การสั่งพิมพ์ในขั้นตอนนี้เพื่อสั่งพิมพ์เป็นตัวอย่างของเล่มหนังสือผลงานวิจัยของ สศค.และตรวจทาน 

ความเรียบร้อยของตัวเล่มและข้อความ เช่น ค าผิด ค าฉีก 
 1) ให้ผู้จัดท าคลิกแท็บ File (แฟ้ม) และคลิก Print  

 

 2) เลือกเครื่องพิมพ์  และตั้งค่าการพิมพ์เป็น Booklet, side-fode หลังจากนั้นคลิกสั่งพิมพ์  

 

1 

2 

1 

2 

3 



บทที่ 4 
ขั้นตอนกำรด ำเนินงำนจัดพิมพ์ 

หนังสือผลงำนวิจัยของ สศค. ประจ ำปีงบประมำณ 

ในการจัดพิมพ์หนังสือผลงานวิจัยของ สศค. ทุกครั้ง ผู้จัดท าต้องท าการเรียบเรียงเนื้อหาทุกส่วนให้
แล้วเสร็จ รวมถึงจัดเตรียมไฟล์ข้อมูลทั้งนามสกุล Publisher (.pub) และ PDF (.pdf) และไฟล์รูปภาพ 
ให้บริษัทที่ถูกว่าจ้างให้จัดพิมพ์ โดยมีขั้นตอนดังนี้ 
 1) ศวบ. ด าเนินการประสานงานกับบริษัทที่จะให้จัดพิมพ์หนังสือผลงานวิจัยของ สศค.  
เพ่ือท าข้อตกลงเกี่ยวกับรายละเอียดการจัดพิมพ์ตัวเล่ม รูปแบบตัวเล่ม ชนิดกระดาษ จ านวนเล่มที่ตีพิมพ์ 
เพ่ือให้บริษัทท าการประเมินราคาและน าส่งใบเสนอราคาส าหรับการจัดพิมพ์รูปเล่มให้ ศวบ. เพ่ือด าเนินการ 
ของบประมาณในการจัดพิมพ์หนังสือผลงานวิจัยของ สศค. (ภาคผนวกท่ี 1) ทั้งนี้ รายละเอียดคุณสมบัติ 
ที่จัดพิมพ์มีลักษณะดังต่อไปนี้ 
  - รูปแบบตัวเล่มขนาด A5 เข้าเล่มใส่สันกาว 
 - หน้าปกใช้กระดาษ Tom&Otto พิมพ์สี เคลือบ PVC 
 - เนื้อหาใช้กระดาษถนอมสายตาขนาด 75 แกรม พิมพ์ขาวด า 
 - ภาพกิจกรรมใช้กระดาษถนอมสายตาขนาด 75 แกรม พิมพ์สี 
 - จ านวนเล่มที่ตีพิมพ์ 500 เล่ม 
หมำยเหตุ การจัดพิมพ์หน้าปกสามารถด าเนินการได้ 2 ลักษณะ คือ 
              1) การพิมพ์แบบ Offset Print 
              2) การพิมพ์แบบ Digital Print 
             ทั้งนี้ข้ึนอยู่กับความเหมาะสมของราคาและคุณภาพในแต่ละปีงบประมาณ 
 2) ศวบ. ประสานงานกับส่วนบริหารงานพัสดุ ส านักงานเลขานุการกรม (สลข.) เกี่ยวกับระเบียบ 
การจัดซื้อ จัดจ้าง และการกันเงินเพ่ือขอใช้เงินจากงบประมาณของ สศค. 
 3) ศวบ. จัดท าบันทึกเสนอผู้อ านวยการ สศค. (ผ่านรองฯ) เพ่ือขออนุมัติการจัดพิมพ์และอนุมัติ
ค่าใช้จ่ายในการจัดพิมพ์ตามจ านวนวงเงินที่ระบุในใบเสนอราคา และให้ สลข. เป็นผู้ด าเนินการจัดจ้างต่อไป 
(ภาคผนวกท่ี 2) 
 4) บริษัทด าเนินการประสานงานกับ ศวบ. เพื่อส่งตัวอย่างหนังสือผลงานวิจัยของ สศค.ให้ตรวจสอบ
รายละเอียดความถูกต้อง ความครบถ้วน และความสมบูรณ์ของเนื้อหาในตัวเล่ม รวมทั้งหน้าปกก่อนตีพิมพ์
ฉบับสมบูรณ์  
 5) ศวบ. ด าเนินการจัดท าบันทึกถึง สลข. เพ่ือให้ สลข. ด าเนินการสั่งการไปยังส่วนบริหารงานพัสดุ 
เมื่อส่วนบริหารงานพัสดุรับเรื่องแล้วจะด าเนินการประสานงานไปยังบริษัท รวมถึงด าเนินการแต่งตั้ง
คณะกรรมการตรวจรับพัสดุ เพ่ือตรวจรับหนังสือผลงานวิจัยของ สศค. ทั้งนี้ ศวบ. จะต้องด าเนินการเสนอ
รายชื่อ บุคลากร ศวบ. จ านวน 2 ท่าน เพ่ือด าเนินการท าหน้าที่เป็นประธานและกรรมการในการตรวจรับ  
(ภาคผนวกท่ี 3) 
 6) บริษัทด าเนินการจัดพิมพ์เป็นรูปเล่มตามรายละเอียดที่ท าข้อตกลงไว้ เมื่อท าการจัดพิมพ์เรียบร้อย
แล้วบริษัทจะส่งมอบหนังสือผลงานวิจัยของ สศค. ให้แก่คณะกรรมการตรวจรับตามจ านวนที่ตกลงกันไว้ 
ในใบเสนอราคา เพ่ือให้คณะกรรมการตรวจรับตรวจสอบความถูกต้องว่าเป็นไปตามเงื่อนไขหรือข้อตกลง 
ในใบเสนอราคาของการจัดพิมพ์หนังสือผลงานวิจัยของ สศค. หรือไม ่ 
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 7) ศวบ. ด าเนินการเผยแพร่หนังสือผลงานวิจัยของ สศค. ประจ าปีงบประมาณผ่าน 7 ช่องทาง ได้แก่ 
(1) ห้องสมุด สศค. (2) ผู้บริหาร สศค. (3) หัวหน้าของหน่วยงานต่างๆ ใน สศค. (4) งานสัมมนาวิชาการ
ประจ าปีของ สศค. (5) โครงการฝึกอบรมหลักสูตรกลางของโรงเรียน สศค. (6) หน่วยงานทั้งภาครัฐและเอกชน 
(7) เว็บไซต์ย่อยของ สศค. ที่ http://www.fpo.go.th/e_research/ (ภาคผนวก 4) 

ภำพที่ 4.1 กำรด ำเนินงำนจดัพิมพ์หนังสือผลงำนวิจัยของ สศค. 

 

                   

ที่มา : ศูนย์บริหารงานวิจัยและบรรณสารสนเทศ (2560) 

หมำยเหตุ ระยะเวลาในการด าเนินการจัดพิมพ์หนังสือผลงานวิจัยของส านักงานเศรษฐกิจการคลัง 
ในแต่ละปีงบประมาณอาจมีการเปลี่ยนแปลง ทั้งนี้ขึ้นอยู่กับช่องทางการเผยแพร่แต่ละช่องทาง                                             

เม.ย. 
• ติดต่อบริษัท 

เม.ย. 
• ติดต่อ สลข. 

เม.ย. 
• ขออนุมัติจัดพิมพ์ และเบิกจ่ำย 

พ.ค. 
• ตรวจสอบควำมสมบูรณ์ของตัวเลม่ 

พ.ค. 
• เสนอชื่อจัดตั้งคณะกรรมกำรตรวจรับ 

พ.ค. 
• จัดพิมพ์ตัวเล่ม 

มิ.ย. 
• ตรวจรับ 

มิ.ย. 
• เผยแพร ่

ระยะเวลาการด าเนินงาน 

http://www.fpo.go.th/e_research/


บทที่ 5 
กำรเผยแพร่หนังสือผลงำนวิจัยของ สศค. 

ประจ ำปีงบประมำณ 

ภายหลังจากหนังสือผลงานวิจัยของ สศค. ที่ได้รับการตีพิมพ์และผ่านการตรวจรับเรียบร้อยแล้ว ศวบ. 
จะด าเนินการเผยแพร่หนังสือผลงานวิจัยของ สศค. ดังกล่าวสู่สาธารณชน ให้แก่บุคลากรภายใน สศค. นิสิต
นักศึกษา ตลอดจนประชาชนทั่วไป ซึ่งมีการเผยแพร่ 2 ช่องทาง ดังรายละเอียดต่อไปนี้ 

5.1 กำรเผยแพร่หนังสือผลงำนวิจัยของ สศค. 
ศวบ. จะเผยแพร่ภายในห้องสมุดของ สศค. และจะด าเนินการมอบให้ผู้บริหารของ สศค. รวมถึงจัดส่ง 

ไปยังหน่วยงานทั้งของภาครัฐและเอกชน เช่น หน่วยงานราชการ ห้องสมุด มหาวิทยาลัยต่างๆ เป็นต้น และให้
ในโอกาสต่างๆ เช่น งานสัมมนาวิชาการประจ าปีของ สศค. โครงการฝึกอบรมหลักสูตรกลางของโรงเรียน สศค. 
เป็นต้น ทั้งนี้ ศวบ. จะด าเนินการท าบันทึกลงทะเบียนการเผยแพร่เพื่อควบคุมจ านวนหนังสือผลงานวิจัย 
ของ สศค. ที่จัดพิมพ์ในแต่ละปีงบประมาณ ซึ่งจะท าให้ทราบถึงรายละเอียดของหน่วยงาน จ านวนหนังสือ 
ที่มกีารน าส่งไปและสามารถน าไปใช้เป็นข้อมูลในการประมาณการจัดพิมพ์ในปีงบประมาณต่อๆ ไป 

ตำรำงท่ี 1 ตัวอย่ำงทะเบียนควบคุมกำรแจกจ่ำยหนังสือผลงำนวิจัยของ สศค. 

ทะเบียนควบคุม 
หนังสือผลงำนวิจัยของส ำนักงำนเศรษฐกิจกำรคลัง (Pocket Book) 

ประจ ำปี 25…..      จ ำนวนทั้งหมด…………..เล่ม 

ที ่ ว / ด / ป 
ชื่อผู้เบิก 

วัตถุประสงค์ 
จ ำนวน 

ลงช่ือผู้จ่ำย 
บุคลำกร หน่วยงำน (เล่ม) 

              
              
              
              

ที่มา : ศูนย์บริหารงานวิจัยและบรรณสารสนเทศ (2560) 

5.2 กำรเผยแพร่หนังสือผลงำนวิจัยของ สศค. ออนไลน์ (e – Book) 
การเผยแพรห่นังสือผลงานวิจัยของ สศค. ออนไลน์ เพื่ออ านวยความสะดวกให้แก่บุคลากรภายใน 

สศค. นิสิต นักศึกษา ตลอดจนประชาชนทั่วไปสามารถเข้าถึงได้ง่าย สะดวก และรวดเร็วมากยิ่งขึ้น ศวบ.  
จึงได้ท าหนังสือผลงานวิจัยของ สศค. ในรูปแบบหนังสือออนไลน์ บนเว็บไซต์ย่อยของ สศค. ที่ 
http://www.fpo.go.th/e_research ซึ่งเป็นเว็บไซต์ที่ ศวบ. ใช้เผยแพร่ผลงานวิจัยออนไลน์ของ สศค.  
ที่ได้จัดท าขึ้นตั้งแต่ปีงบประมาณ พ.ศ. 2551 – ปัจจุบัน ผู้ใช้สามารถค้นหาโครงการวิจัยได้ตามหมวดหมู่ 
หรือปีงบประมาณ นอกจากนี้ภายในเว็บไซต์ยังมีข้อมูลด้านการบริหารงานวิจัย ได้แก่ โครงสร้าง ศวบ. 
จรรยาบรรณการวิจัย ขั้นตอนการบริหารงานวิจัย คู่มือการปฏิบัติงาน (Work Manual) ภาพกิจกรรม 
ในการจัดสัมมนาทางวิชาการ และ e – Book ที่หนังสือออนไลน์เผยแพร่มากมาย เช่น โครงการวิจัย,  
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งานวิจัยจาก HiPPs, Research Update, Research Update, ท าเนียบการวิจัยคู่มือการปฏิบัติงาน 
และหนังสือผลงานวิจัยของ สศค. ที่จะเผยแพร่ผ่าน Pocket Book  

ดังนั้น วิธีการเผยแพร่หนังสือผลงานวิจัยของ สศค. ผู้จัดท าจะต้องเตรียมไฟล์ในรูปแบบของ PDF ไฟล์ 
(ท่ีรวบรวมเนื้อหาทั้งเล่ม) และไฟล์ภาพหน้าปก (นามสกุล .jpg) ให้พร้อม และเพ่ือให้การเผยแพร่บนเว็บไซต์
สมบูรณ์ ขอแบ่งการท างานเป็น 2 ส่วน ดังนี้ 

 5.2.1 ขั้นตอนกำรรวมไฟล์หนังสือผลงำนวิจัยของ สศค. เพื่อท ำเป็นหนังสือออนไลน์  
1) ไปที่โฟลเดอร์ที่เก็บไฟล์ PDF หลังจากนั้นคลิกเลือกไฟล์ที่ต้องการรวมทั้งหมด 
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2) คลิกขวาเลือก Combine support files in Acrobat…  

 

3) คลิก Combine Files รอโปรแกรมท างานจนเสร็จสมบูรณ์ 
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4) เลือกต าแหน่งที่ต้องการจัดเก็บไฟล์ เลือกโฟลเดอร์ Pocket Book 59 > PB.pdf  
และตั้งชื่อไฟล์  (File name: ) หลังจากนั้นกด Save 

 

 5.2.2 ขั้นตอนกำรเผยแพร่ผ่ำนเว็บไซต์ e – Research ในรูปแบบของ e - Book 
1) เข้าเว็บไซต์ http://www.fpo.go.th/e_research/  

               คลิกเลือก E-Book จากแถบเมนูด้านซ้าย  

 
 

 

 

http://www.fpo.go.th/e_research/


ศูนย์บริหารงานวิจัยและบรรณสารสนเทศ  43 
 

2) คลิก Administrator เข้าสู่ระบบผู้ดูแล เพ่ืออัพเดทหนังสือผลงานวิจัยของ สศค. ฉบับล่าสุด 

 
3) กรอกชื่อผู้ใช้และรหัสผ่าน หลังจากนั้นคลิก Login เพ่ือเข้าสู่ระบบ 

 
4) คลิกเลือกเพ่ิมรายการหนังสือ 
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5) คลิกเลือกหมวดหนังสือ Pocket Book และกรอกรายละเอียดของหนังสือ หลังจากนั้นคลิก 
เพิ่มหนังสือ Pocket Book ก็จะไปปรากฏบนชั้นหนังสือ 

 
6) คลิก เมนูหลัก เพ่ือ Logout ออกจากระบบ 

 
 

 

 

 

 

 

 

 

 

 

 

กรอกรายละเอียดของหนังสือ 4 

คลิกเลือกหมวดหนังสือ Pocket Book 1 

คลิกเพิ่มหนังสือ 6 

ใส่ช่ือหนังสือ 2 

ไฟล์ภาพหน้าปก 3 

ไฟล์หนังสือฉบับพกพา 5 



 

 

 

 

 

 

 

ภำคผนวกที่ 1  

 ตัวอย่างใบเสนอราคาและรายละเอียดในการจัดพิมพ์ 
หนังสือผลงานวิจัยของ สศค. 
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ภำคผนวกที่ 2  

 ตัวอย่างบันทึกการกนัเงินและขออนุมัติค่าใช้จ่ายในการจัดพิมพ์ 
หนังสือผลงานวิจัยของ สศค. 
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ภำคผนวกที่ 3  

 ตัวอย่างบันทึกถึง สลข. เพื่อด าเนินการจัดซ้ือจัดจ้าง 
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ภำคผนวกที่ 4  

 ตัวอย่างหนังสือผลงานวิจัยของ สศค. ประจ าปีงบประมาณที่ผ่านมา ซึ่งใช้
ในการเผยแพร่ผ่านช่องทางสื่อต่างๆ เช่น งานสัมมนา วิชาการของ สศค. 
ห้องสมุดและน าเสนอต่อผู้บริหาร สศค. 

 ตัวอย่างการเผยแพรห่นังสือผลงานวิจัยของ สศค. ประจ าปีงบประมาณ
ผ่านช่องทางอิเล็กทรอนิกส์ (e – Book) 
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